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1 Appliance information  

 Introduction 

This guide provides information about the “SAP S/4HANA 2021 (FPS02) Fully Activated Appliance” on SAP Cloud 

Appliance Library (SAP CAL, https://cal.sap.com ). 

The appliance contains an SAP S/4HANA system with pre-configured SAP Best Practices and demo scenarios.  

Typical use cases are trial, sandboxing, proof-of-concept, or scoping exercises.  

The usage as a development system in implementation projects is not recommended since the appliance might 

contain components and configuration settings (some with a separate license) that are conflicting with the later 

deployment in a quality or production system. 

Via SAP Cloud Appliance Library, the appliance can be rapidly brought up as your personal appliance with 

administrative rights in dedicated hyper-scalers such as Amazon, MS Azure or Google Cloud Platform (setup time 

~2 hours).  

SAP also offers to use the appliance on your own hardware e.g. in your data center (setup time usually ~2-3 days), 

please see SAP Note 2041140 if you are interested in this deployment option. 

 

Important:  

Once the system has been successfully provisioned in your SAP CAL account, it is under your ownership and 

control (you have all-area admin authorizations in your appliance). SAP does not access or maintain this system 

in any way after provisioning, and you will not receive any updates by SAP. 

If you consider upgrading to a higher release (either major release or an FPS), this will need to be done as a 

customer-specific project (using maintenance planner, SUM, etc.). In many cases it might be easier to create a 

new appliance for the newer release, and transport/export any important artifacts from the older release. 

 

Further information: 

- A general introduction into the appliance and the usage as trial or sandbox system can be found on 
https://blogs.sap.com/?p=727457 

- Known issues will be continuously updated in this blog: https://blogs.sap.com/?p=1440551 . 

- Extensive demo guides with sample walkthrough scenarios can be found here: 

https://blogs.sap.com/2019/04/23/sap-s4hana-fully-activated-appliance-demo-guides/. 

- Video tutorials how to create an AWS account and how to launch the appliance can be found here.  They 

might not necessarily show the creation of the SAP S/4HANA 2021 appliance (but another SAP 

appliance template), however, the concepts are the same.  

 

  

https://cal.sap.com/
https://launchpad.support.sap.com/#/notes/2041140
https://blogs.sap.com/?p=727457
https://blogs.sap.com/?p=1440551
https://blogs.sap.com/2019/04/23/sap-s4hana-fully-activated-appliance-demo-guides/
https://blogs.sap.com/2021/03/19/sap-cal-learning-videos-update/
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 Installed products 

When you deploy the appliance, you get access to a system landscape that has been built using the following 

components (see picture below). 

1. SAP S/4HANA 2021 FPS02 (on the SAP HANA database) 

2. SAP NetWeaver 7.50 JAVA with Adobe Document Services (on Sybase ASE database) 

3. Optional: Microsoft Windows Server 2016 (as remote desktop) for easy frontend access. 

4. Optional: SAP BusinessObjects BI Platform 4.3 SP1 

 

Notes:  

• The virtual machines (VMs) for the BI Platform and the remote desktop (RDP) are optional in Cloud 

Appliance Library. You can deselect these two VMs in the Advanced Mode of the appliance creation. 

Once an appliance has been created, this choice cannot be changed anymore for this appliance. 

Please consider deploying the remote desktop (even if it slightly increases the hyperscaler costs) since it 

provides a good way of testing and troubleshooting potential network access issues. 

• The BI Platform and the remote desktop are only available when using SAP Cloud Appliance Library as 

described in this document. However, you can also receive the virtual appliance for installation on your 

own on-premise hardware but in that case BI platform and remote desktop are not included. Please see 

SAP Note 2041140 for the option to install the virtual appliance on your own hardware.  

 

A detailed component list of the appliance can be found in the appendix of this guide.  

 

 

  

https://launchpad.support.sap.com/#/notes/2041140
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 Business scenarios & localizations 

The appliance uses SAP Best Practices as main business content.  

   The charts below summarize the Best Practices scope for SAP S/4HANA 2021 (details can be found on 

https://rapid.sap.com/bp/BP_OP_ENTPR). 

 

https://rapid.sap.com/bp/BP_OP_ENTPR
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In the appliance, the Best Practices have been fully activated, however, there are still areas that require additional 

configuration to be fully functional.  

The integration into other SAP products or 3rd party software is such an example where you need to specify at 

least the credentials (tenant, account, etc.) of the integration target.  

 

The SAP Best Practices configuration content of SAP S/4HANA 2021 is available for 43 local versions and 25 

languages (see below slide). 

 

In the appliance, all available localizations are activated in client 400 (see the section ABAP client structure & 

business users later in this guide), however, the suggested demo walkthroughs incl. demo data in the appliance 

are configured for USA only, using the company code 1710. 

 

Besides the languages for SAP Best Practices, further language packages are installed in the system, but the 

configuration content might not be fully translated into those. 
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 ABAP client structure & business users 

Multiple ABAP clients are configured in the appliance: 

• 000 serves as standard delivery client (as usual in on-premise deployments) 

• 100 is the primary demo client that contains the pre-configured scenarios and sample data.  

• 200 can be used for activating the SAP Best Practices on your own.  

Please  see the SAP Best Practices implementation guide for details. Be aware that some of the SAP 

Notes and settings mentioned in the guide still need to be applied depending on what country or scope 

you activate (e.g., the parameter rdisp/scheduler/prio_high/max_runtime is not set accordingly 

yet as required by the guide). 

• 400 contains the activated Best Practices (BP) based on the BP client approach for all localizations. This 

is the standard BP business content as it was delivered with SAP S/4HANA 2021 SP00 (no corrections or 

additional configuration changes were applied). 

 

 

Please see chapter 2 for default users and logon procedures. 

 

(*) For the US localization, SAP Best Practices are delivered with internal tax calculation. This includes sample 

jurisdiction codes and sample rates so that you can execute the best practices test scripts. The organizational 

structure and chart of accounts are activated with SAP Best Practices sample content.  

Client 200 does not contain these settings. 

(**) For information on the differences between an SAP Best Practice and a merged-000 client, please see here. 

Especially please make sure to understand that client 400 does not contain the whole “usual” customizing that 

you might know from client 000. Therefore, especially if you use scenarios outside the SAP Best Practices scope, 

they might not work as expected without further customizing by you (you might even experience coding errors 

due to this). 

https://help.sap.com/viewer/4cef93946a0b48ec89533b3c34443b85/2021/en-US/17d958a88d244ee293aed687f9bfe37f.html
https://help.sap.com/viewer/4cef93946a0b48ec89533b3c34443b85/2021/en-US/8a5680cd5c2045d3b461bc7f35b25a64.html
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 Sample demo walkthroughs 

Once you have created an appliance in SAP Cloud Appliance Library you will have a principally working S/4HANA 

system that you can explore and change on your own.  

To give you a jump-start into the contained scenarios, we have documented a wide range of example scenarios 

that we recommend as starting point to get more familiar with the system.  

Please see this blog (https://blogs.sap.com/2019/04/23/sap-s4hana-fully-activated-appliance-demo-guides/)  

for the available demo guides (choose the applicable release). 

These demo guides take you on a “guided tour” through some of the pre-configured areas, but you are also free to 

step away from these tours.  

However, if you explore additional features of the SAP S/4HANA system beyond what is provided in the demo 

guides, you might find functions or processes that are not pre-configured and, hence, will not provide a 

meaningful system response. In this case, you need to configure those scenarios or functions using SAP standard 

procedures (e.g., via transaction SPRO) to make them work. 

You might also find errors as you explore the appliance. In this case, please search for SAP Notes and corrections 

and decide if you want to apply them. Your appliance behaves like a regular customer system and will not be 

updated automatically by SAP i.e., you will need to implement these fixes in your system. 

 Recommended post-installation steps 

As said above, your appliance will be a working system, however, since the appliance is entirely under your control 

(SAP does not maintain it) there are certain settings that you might need to adapt depending on your use case, for 

example: 

 

1. Evaluate and adapt security settings  

When you create the appliance in your hyperscaler account, by default it will be deployed in the public 

Internet, i.e., everyone with Internet connectivity can access your system.  

We strongly recommend applying additional security measures as you consider it needed for your 

context. Chapter 4 of this guide mentions typical aspects and suggestions. 

 

2. Open the MM inventory management period for the current month if you intend to post goods 

movements.  

The above blog with the sample demo scenarios explains how to do this in section C  . 

 

3. Check further time-dependent settings if you face issues  

This is like adapting the MM period above: Since the appliance comes in a defined state (with 

development close some time before you start your appliance), you might need to adapt time-dependent 

settings e.g., validity dates of master/meta data, certain finance periods, time-dependent production 

windows, and so on. 

 

4. Register the appliance system under your customer installations and apply license keys.   

Please see chapter 3 of this guide for details, in summary you will need to consider two timelines: 

- If you intend to use the system beyond 30 days, you will need to possess licenses for SAP S/4HANA 

and SAP Cloud Appliance Library 

https://blogs.sap.com/2019/04/23/sap-s4hana-fully-activated-appliance-demo-guides/
https://blogs.sap.com/2019/04/23/sap-s4hana-fully-activated-appliance-demo-guides/
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- If you intend to use the system beyond 90 days, you will need to generate and apply your own license 

keys to the HANA DB, S/4HANA, and JAVA 

 

Both options are only possible with an S-user (i.e., a registered SAP customer user).  

A public P-user can only register for the 30-day trial. 

 

5. Create own business users if the pre-configured demo users are too “heavy”.  

The pre-configured S/4HANA demo users (see section 3.4.1.1.) often have many roles assigned to enable 

them for a broad business scenario, and they mostly have an SAP_ALL authorization profile. 

If these users are too broad for your specific project, you could either create your own users in tCode 

SU01 (there is no contractual limit for user numbers during the trial period) or use the SAP Fiori Rapid 

Activation to create user with tailored role assignments (see the demo walkthrough page in the User 

Experience section for the respective guide).  

 

6. Enable the automatic download of SAP Notes 

The appliance has been technically prepared for connecting it to the SAP support backbone 

infrastructure.  

However, for using the automatic download and application of SAP Notes (via tCode SNOTE), you need 

to enter your customer-specific S-User credentials in the usual SM59 RFC destinations (SAP-

SUPPORT_PORTAL, SAP-SUPPORT_PARCELBOX, SAP-SUPPORT_NOTE_DOWNLOAD). 

 

7. On the included remote desktop:  Install Eclipse (incl. HANA plug-ins) and change the default browser  

 

Installing Eclipse 

The Welcome page on the remote desktop has detailed instructions how to use the provided PowerShell 

script. If you like, you can also manually install Eclipse and the corresponding SAP plug-ins from 

https://tools.eu1.hana.ondemand.com/  

 

Default browser 

The remote desktop uses Internet Explorer (IE) as default browser. Since IE is deprecated by Microsoft 

and does not support many SAP applications anymore, you might get error messages if you open a web-

based transaction (NWBC, BRF+, etc.) from the SAP GUI.  

 

There are two options how to overcome this: 

 

(1)  

We recommend to change the default browser on the remote desktop to Chrome or Edge since these 

browsers will work with the SAP GUI (to do this, search for “Choose a default browser” in the Windows 

menu and change the browser icon in the app). 

 

(2)  

If (1) is not suitable for whatever reason, you can also enable the myssocntl  service in S/4:  

tCode SICF → right-click on service “default_host > sap > public > myssocntl” → Activate → Confirm. 

With this setting, web-based transactions will use the browser that is defined in the installed SAP Logon 

options (in SAP Logon, choose Options > Interaction Design > Control Settings > HTML Control ). On the 

remote desktop, this uses MS Edge/Chromium as default. 

This setting will  also eliminate the need to enter an additional logon in certain business scenarios that 

merge SAP GUI and browser content. 

However, there is a potential issue with this setting when using SAP GUI directly from your corporate PCs 

https://tools.eu1.hana.ondemand.com/


 

  11 

 

(without remote desktop) since the above HTML control requires SAP GUI 7.70. If your business users 

have older SAP GUI versions installed on their local PCs, they might get errors when opening web 

transactions from a local SAP Logon.  

SAP Note 2624143 describes the background. 

 More information & support 

1.7.1   More information 

Overview blog in SAP Community: https://blogs.sap.com/?p=727457  
 

Known issues blog in SAP Community: https://blogs.sap.com/?p=1440551  

 

Post installation steps and sample demo walkthroughs: 

(https://blogs.sap.com/2019/04/23/sap-s4hana-fully-activated-appliance-demo-guides/ 

 

SAP S/4HANA Trial Landing Page (also containing a “Quick Start Guide” how to set up the appliance)  

https://www.sap.com/cmp/oth/crm-s4hana/s4hana-on-premise.html 

 

Video tutorials (how to create Cloud Provider accounts and start an SAP S/4HANA appliance): 

https://blogs.sap.com/2021/03/19/sap-cal-learning-videos-update/  

1.7.2   Support 

If you run a 30-day trial (i.e., no SAP Cloud Appliance Library subscription license), please use the SAP 

Community (preferably take SAP Cloud Appliance Library as it’s closely monitored): 

• SAP Cloud Appliance Library (for Cloud Appliance Library usage, access, etc.):  

https://answers.sap.com/tags/67837800100800004473  
 

• SAP S/4HANA (for S/4 specific functional questions): 

https://answers.sap.com/tags/73554900100800000266  

 

If you have an SAP Cloud Appliance Library subscription license acquired, you can also report an incident 

(component BC-VCM-CAL). Ideally you have registered your appliance system under your customer installations 

before so that you can report the incident on the right system. 

https://launchpad.support.sap.com/#/notes/0002624143
https://blogs.sap.com/?p=727457
https://blogs.sap.com/?p=1440551
https://blogs.sap.com/2019/04/23/sap-s4hana-fully-activated-appliance-demo-guides/
https://www.sap.com/cmp/oth/crm-s4hana/s4hana-on-premise.html
https://blogs.sap.com/2021/03/19/sap-cal-learning-videos-update/
https://answers.sap.com/tags/67837800100800004473
https://answers.sap.com/tags/73554900100800000266
https://support.sap.com/en/my-support/incidents.html
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2 Accessing the appliance 

 Overview 

The appliance can be accessed via a preconfigured Windows remote desktop (option 1) or via client tools on your 

local PC (option 2). 

For the first steps with the appliance (especially for the personnel that has set up the appliance), we recommend 

the access via the remote desktop since it has multiple client tools and pre-configurations included.  

However, since only two users can log on to the remote desktop in parallel (at least without additional Microsoft 

licenses), this might be impractical if you want to provide the appliance to additional users. For this case, the 

access via a local computer will be better suited but for full access to all Fiori capabilities you will either need to 

modify the local /etc/hosts file (see chapter 2.3.1) or apply a fully-qualified host name to your appliance (see 

chapter 2.3.2). 

 Option 1: System access via embedded Windows Remote 
Desktop frontend server 

 After your own appliance is created, click the Connect button in the Appliances view of the console. 
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 In the pop-up, click Connect in the “RDP Virtual Machine: Windows Remote Desktop” line. 

 

 

 Confirm the pop-up window to allow Remote Desktop Connection (click on “Connect”). 

Enter user Administrator (local domain of the remote desktop) and your <Master Password> that you 

specified during the appliance creation in the SAP Cloud Appliance Library console. 
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 Next you will see the pre-configured Windows RDP server.  

Follow the information on the Welcome page to logon to the SAP S/4HANA system (Fiori link, SAP 

GUI/HANA Studio are pre-installed on the desktop, etc.). The Welcome page shortcut on the desktop points 

to C:/ProgramData/WelcomePage/Welcome.html. 

More details on pre-configured appliance users can be found in section 2.4. 

 

 Further remarks: 

- The embedded Windows Remoted Desktop license allows 2 concurrent sessions (e.g., one for the 

existing user Administrator and one for another user that you can create on the remote desktop). 

Installing your own RDP license might also be an option to allow more concurrent users on the RDP.  

- Eclipse and the needed SAP plugins for accessing the HANA database will not be installed by default. 

Please execute the MS PowerShell script on the desktop to automatically install Eclipse and the 

needed SAP plugins (the Welcome page on the RDP has more details). 

- If your cloud provider infrastructure has restricted Internet access (e.g., it is a fenced environment), 

the remote desktop will not be fully provisioned 

o Chrome will not be installed → use Firefox for Fiori access or install Chrome at a later point 

in time if this is possible in your network setup  

o The Welcome page will not show up on the desktop, but you can find it on the remote 

desktop in the folder Q:\flavor\S4HANA_Fully_Activated\WelcomePage.  

o The PowerShell script for installing Eclipse can be found on 

D:\applianceagent\eclipseinstall.ps1 

 Option 2: System access via local PC 

When accessing the system via your local PC, you will need to have the respective programs installed. A local 

browser (Chrome preferred) is obvious, but also a local SAP GUI, SAP Business Client or SAP HANA Studio 

(based on Eclipse) might be needed. 
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For SAP GUI access, you can use the “Connect → SAP GUI” option in the Cloud Appliance Library console (same 

as for the remote desktop) and a local SAP GUI will open. 

Or you can add the Cloud Appliance Library appliance to your local SAP Logon Pad or HANA Studio (use the 

external IP address of the ABAP/HANA virtual machine as host name, further details like system numbers, etc. 

are listed in section 2.4 ).  

However, the access to the Fiori launchpad via IP addresses will not work for apps that are based on WebGUI or 

Web Dynpro. For those to work, you will need to map the /etc/hosts file as described in the next section. 

As an alternative to the hosts file mapping and if you have access to a DNS service (corporate, free internet 

service, or the hyperscaler provides a  host name), you can also apply your own host and domain name to the 

system, possibly together with a registered SSL certificate. See section 2.3.2 of this guide for details.  

2.3.1   Mapping your local /etc/hosts file 

To make all Fiori launchpad capabilities work correctly when you access the appliance from your local computer, a 

mapping between the (external) IP address of your appliance and the appliance host name must be established. 

This mapping step is needed since the connection to the cloud providers uses IP addresses, whereas the 

S/4HANA system expects dedicated host names to work correctly.  

In the appliance the pre-defined host names in the appliance template are vhcals4hcs(and vhcals4hci) on 

the fictious domain dummy.nodomain.  

The easiest way to achieve this mapping is via editing a standard file on your local computer. 

(C:\Windows\system32\drivers\etc\hosts). However, you will need to have local administrator rights on 

your computer to edit this file. 

After you have done the mapping, you will be able to access the Fiori Launchpad of SAP S/4HANA via this URL: 

https://vhcals4hcs.dummy.nodomain:44301/sap/bc/ui5_ui5/ui2/ushell/shells/abap/FioriLaunchpad.html  

If you cannot map your local hosts file (e.g., you don’t have administrator rights on your computer or there are 

security concerns in your environment), please check chapter 2.3.2 if using your own fully qualified host name is 

an option.  

For some isolated use cases, you can also put the external IP address of your S/4HANA & HANA appliance in the 

URL 

(https://<External_IP_Address_SAPS4HANA/HDB_server>:44301/sap/bc/ui5_ui5/ui2/ushell/shells/abap/Fio

riLaunchpad.html), however, not all applications and scenarios will work correctly with it e.g., WebGUI or Web 

Dynpro applications will not display in the browser, so you might hit issues in some business scenarios. 

 

The following describes how to modify the local hosts file on a Windows computer (for Mac, please search the 

Internet for options).  

 

 Open Notepad as administrator (search for Notepad on your computer > Right mouse click > Run as 

administrator): 

 Click File → Open and enter the following path: 

For Windows operating system:  C:\Windows\system32\drivers\etc\hosts  

For Linux operating system: /etc/hosts 

 Ensure to select All Files (*.*) 

 Open the hosts file and add the following lines to it (the IP addresses for the servers are displayed in the Cloud 

Appliance Library console in the appliance properties, take the external IP address): 

https://vhcals4hcs.dummy.nodomain:44301/sap/bc/ui5_ui5/ui2/ushell/shells/abap/FioriLaunchpad.html
https://vhcals4hcs.dummy.nodomain:44301/sap/bc/ui5_ui5/ui2/ushell/shells/abap/FioriLaunchpad.html
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# S4H Appliance 

<External IP Address SAP S4HANA/HDB server> vhcals4hci.dummy.nodomain vhcals4hci 

vhcals4hcs.dummy.nodomain vhcals4hcs vhcalhdbdb vhcaldhbdb.dummy.nodomain 

<External IP Address SAP NW JAVA/ASE/ADS server> vhcalj2eci.dummy.nodomain vhcalj2eci 

vhcalj2ecs.dummy.nodomain vhcalj2ecs vhcalj2edb vhcalj2edb.dummy.nodomain 

<External IP Address SAP BI Platform> bihost bihost.dummy.nodomain  

 

 Save the hosts file and exit. 

2.3.2 Use your own fully-qualified host name 

As written above, the SAP S/4HANA host name and the (external) IP address of your appliance need to be 

mapped.  

Instead of mapping the fictious *.dummy.nodomain host name via the /etc/hosts file, you can also register a 

regular host/domain name in a DNS server of your choice and route this host name to the IP address.  

In a “corporate IT context” you might eg. use your own corporate DNS resolution for the SAP S/4HANA system. 

This is typically done by the customer network / security basis team.  

Or if the appliance runs outside a “corporate IT context”, you could either use a public no/low cost DNS provider 

or check if the host name resolution of your hyperscaler can be used. For example, in AWS the machines typically 

follow a nomenclature like “ec2-<external_IP_Address>.compute-1.amazonaws.com” (use nslookup 

<External IP Address>  to check). 

 

Once you have mapped the IP address and a DNS name, the Fiori launchpad can be reached under 

https://<Your_host_name>:44301/sap/bc/ui5_ui5/ui2/ushell/shells/abap/FioriLaunchpad.html , however 

some further settings need to be adapted in the S/4HANA system. 

On the demo walkthrough page a technical demo guide (in section (A) Demo Guides → Technical) shows the most 

relevant parameters that need to switched from the fictious *.dummy.nodomain host name to your real host 

name.  In addition, the guide also explains how to install a free 90-day Let’s Encrypt SSL certificate eg. if you are 

using the appliance outside a corporate IT context.  

Please be aware that the mentioned guide is meant to provide a quick workaround and might not comply with the 

security recommendations that are issued by your company or by SAP in general. 

 Users & passwords for the system components 

Note upfront:  

For URLs starting with vhcal… you will need to map your /etc/hosts file as described in chapter 2.3. 

https://blogs.sap.com/2019/04/23/sap-s4hana-fully-activated-appliance-demo-guides/
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2.4.1         SAP S/4HANA ABAP application server 

2.4.1.1 Pre-configured business users in SAP S/4HANA 

Client Business Content Sample users  

(password Welcome1 if not noted otherwise) 

000 

Standard delivery client 

• Nothing specific 

(standard customizing only) 

• BPINST 

• DDIC / SAP* (<Master_Password> 

100 

 

Trial & Exploration client 

• Pre-activated SAP Best 

Practices for SAP S/4HANA 

2021 (Germany & US, sample 

demo flow localized for US) * 

• Customizing and 

transactional data in US 

company code (1710) 

• SAP Fiori Apps  

• Based on the merged-client-

000 approach 

 

 

 

 

 

 

 

Note on the users: 

The demo users have a relatively broad 

set of roles and Fiori apps assigned for 

their respective functional area and 

should be primarily used for the 

suggested demo walkthroughs.  

 

These users may have longer loading 

times in the Fiori launchpad, especially 

when using them for the first time or 

after a system suspension.  

Feel free to copy them to new user IDs 

(using transaction SU01) and adapt 

those new users to your needs. 

• S4H_AA_DEM / S4H_AA 

(Asset Accounting) 

• S4H_FIN_DEM / S4H_FIN 

(Finance) 

• S4H_CASH_DEM / S4H_CASH 

(Cash Management) 

• S4H_CO_DEM / S4H_CO 

(Controlling) 

• S4H_MM_DEM / S4H_MM 

(Materials Management) 

• S4H_PP_DEM / S4H_PP 

(Production Planning) 

• S4H_PM_DEM / S4H_PM 

(Plant Maintenance & Quality 

Mgmt.) 

• S4H_SD_DEM / S4H_SD 

(Sales & Distribution) 

• S4H_EXT 

(Extensibility) 

• S4H_EWM_DEM 

(Warehouse Management) 

• S4H_PPM_...  

(Portfolio & Project Management) 

• S4H_TM_DEM (Transportation 

Management) 

• S4H_PRED 

(Predictive Analytics) 

• S4H_MG 

(Data Migration) 

• SERV_EMPL / SERV_MAN / 

SLS_MAN / IC_AGENT_SRV  

(SAP S/4HANA Service) 

• MDG_...  

(Master Data Governance) 

• S4H_HCM_…  

(Human Capital Management) 

https://blogs.sap.com/2019/04/23/sap-s4hana-fully-activated-appliance-demo-guides/
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Client Business Content Sample users  

(password Welcome1 if not noted otherwise) 

• FIORIADMIN (Fiori customizing & 

roles) 

• S4H_AIF / S4H_AIF_ADM 

(Application Interface Framework) 

• BPINST 

(generic technical user) 

200 

Ready-to-Activate client 

(white list) 

• Ready-to-Activate client with 

all pre-activation preparation 

activities executed 

BPINST  (Welcome1) 

DDIC / SAP* (<Master password>) 

400 

SAP Best Practices 

reference client  

(white-list) 

• Pre-activated SAP Best 

Practices for SAP S/4HANA 

2021 without transactional 

data, no changes or 

corrections applied 

• Based on the BP-client 

approach 

BPINST  (Welcome1) 

DDIC / SAP* (<Master password>) 

 

All above users have the default password Welcome1  if not indicated otherwise. 

 

 

 

2.4.1.2 Administrative data & users for SAP S/4HANA 

Connect to SAP S4H using the information in the table below (URLs with the host name vhcal… require hosts file 

mapping before, see chapter 2.3). 

 

Name Value Description 

SID S4H System ID of the SAP system 

Instance 

Number 

00 The instance number of the central instance (CI) 

Clients See section 1.4 These are the pre-configured clients 

Password for 

users DDIC &  

SAP* 

<Master 

Password> in 

client 000. 

Welcome1 in other 

clients 

The master password is the password that you chose in the SAP Cloud 

Appliance Library when creating the appliance. 
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Name Value Description 

ABAP 

administrator 

s4hadm /  

<Master 

Password> 

Additional user for ABAP lifecycle management – start/stop, 

administration, 

SAP Web 

Dispatcher 

administrator 

webadm / 

VA1MPwd_ 

or  

bpinst / 

Welcome1 

Access to Web Dispatcher console: 

https://vhcals4hcs.dummy.nodomain:44301/sap/admin  

User bpinst is case sensitive. 

 

Technical user 

for HANA DB 

connectivity 

(schema user) 

SAPHANADB /  

<Master 

Password> 

See tCode DBACOCKPIT → System Landscape → Database 

Connections for additional usage of the SAPHANADB user 

SAP Cloud 

Connector 

Administrator / 

manage 

Initial credentials for the integrated SAP Cloud Connector (access via 

https://vhcals4hcs.dummy.nodomain:8443) 

2.4.2 SAP HANA DB server 

Two database entities are relevant for the appliance: 

The tenant database (for storing the S/4HANA data) and the system database (for general database settings and 

actions e.g., maintaining the license key for SAP HANA). 

An entry for both is pre-configured in the HANA Studio on the remote desktop but you can also add entries in your 

local HANA Studio.  

 

 

Tenant database (use Single Container when adding it to your local HANA Studio) 

 

Name Value Description 

Tenant DB name  HDB System ID of the HANA DB 

Tenant DB Instance 

Number 

02 Instance number of HANA DB 

HANA SYSTEM user 

name 

SYSTEM /  

<Master Password> 

Standard HANA system user 

HANA administrator 

name 

hdbadm /  

<Master Password> 

Additional user for HANA lifecycle management – 

start/stop, administration functions, recovery. 

Generic HANA DB 

user 

BPINST / Welcome1 Generic user that can be used to access HANA DB  

https://vhcals4hcs.dummy.nodomain:44301/sap/admin
https://vhcals4hcs.dummy.nodomain:8443/
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Name Value Description 

Technical S/4HANA 

user 

SAPHANADB /  

<Master Password> 

Technical user for accessing HANA from the S/4HANA 

server. Defined in /nDBACOCKPIT; HANA schema 

SAPHANADB contains the S/4HANA data 

 

 

 

System database (use Multiple Containers → System DB when adding it to your local HANA Studio, needed e.g., 

for applying your own HANA DB license key) 

 

Name Value Description 

HANA DB system  SYSTEMDB System ID of the HANA DB 

HANA DB Instance 

Number 

02 Instance number of HANA DB 

HANA SYSTEM user 

name 

SYSTEM /  

<Master Password> 

Standard HANA system user 

HANA administrator 

name 

hdbadm / 

<Master Password> 

Additional user for HANA lifecycle management – 

start/stop, administration functions, recovery. 

Generic HANA DB 

user 

BPINST / Welcome1 Generic user that can be used to access HANA DB  

 

2.4.3 SAP NetWeaver JAVA application server 

Name Value Description 

ASE administrator 

name 

sybadm /  

<Master Password> 

Additional user for Sybase ASE lifecycle management – 

start/stop, administration. 

JAVA administrator 

name 

Administrator / 

<Master Password> 

Additional user for JAVA lifecycle management – 

start/stop, administration, functions, recovery. 

Access to SAP NetWeaver Administrator: 

https://vhcalj2eci.dummy.nodomain:50001/nwa 

Additional JAVA user BPINST / Welcome1 Generic user in case other users are locked 

https://vhcalj2eci.dummy.nodomain:50001/nwa
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2.4.4 SAP BusinessObjects BI platform 

Parameter ID Parameter Value Note 

Administrator name Administrator / Welcome1 Use for all administrative functions of 

the BI platform e.g., in CMC 

BI Power User BPINST / Welcome1 Use for BI Launchpad 

SQL Anywhere DB user dba / Appl1ances Use to log on to the DB of the BI 

platform on Linux backend stored under 

/data/bobj/sqlanywhere/database 

BI Platform Linux backend 

user 

bipadm / Welcome1  

 

In the logon screen (http://bihost:8080/BOE/BI), use bihost:6400 as system and Enterprise authentication. 

Usage of the bihost alias requires local host file mapping when using local PC access (see section 2.3). The 

Windows remote desktop has the mapping pre-configured. 

2.4.5  Windows Frontend Server Details  

Connect to the Frontend server using the information in the table below.  

SAP does not provide a separate MS Windows Terminal Server license as part of the appliance; hence, you can 

connect with a maximum of two concurrent users (with different user IDs) at the same time. The Administrator 

account is pre-configured, and you may create additional user IDs in the local user administration of the remote 

desktop if needed.  

If you want to use the remote desktop with higher user numbers, please apply your own MS Terminal Server 

license to the remote desktop and potentially choose a larger sizing for the RDP in the Cloud Appliance Library 

console. But for these high user numbers it’s typically better to enable access via local PCs to the appliance 

system.  

 

Name Value Description 

IP Address <IP Address> The IP address of your frontend server appliance you 

created in SAP Cloud Appliance Library (use the “external” 

IP address) 

User Administrator /  

<Master Password> 

User for the Windows frontend server. This is a local user 

on the remote desktop. Only one Administrator user can 

logon to the front-end server at the same point in time. 

 

A note on browsers:  

Google Chrome and Firefox are pre-installed on the Remote Desktop. In the Fiori launchpad, you might find 

slightly different rendering behaviors depending on the browser version. If you encounter rendering problems, 

please search for SAP Notes how to potentially fix them. 

http://bihost:8080/BOE/BI
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If you want to access the Fiori Launchpad with a local browser, please be sure to map your local host file as 

described in section 2.3 of this document or on https://www.sap.com/cmp/oth/crm-s4hana/s4hana-on-

premise.html → Quick Start Guide since otherwise some Fiori applications (e.g. WebGUI or Web Dynpro) will not 

work correctly. 

2.4.6 Accessing Your Appliance on Linux Level 

You can access the Linux backend system of your appliance (ABAP / JAVA / BI) as root using secure SSH tools, 

e.g., PuTTY 

For information how to access an appliance on OS level, go to https://cal.sap.com/catalog#/support → General 

Technical Questions → How to connect to a running appliance via the secure shell protocol (SSH)? 

 

Parameter ID Parameter Value Note 

OS User Name root The default Linux administrator user 

OS Password <none> Use the generated private key with SSH tools 

 

Note:  

You must use the private key (file format .pem) that was generated in the last step of the Create Appliance wizard 

from SAP Cloud Appliance Library. During the creation, you were asked to either store the key file attached to 

your appliance within SAP CAL or download it to a local secure file share on your computer. 

https://www.sap.com/cmp/oth/crm-s4hana/s4hana-on-premise.html
https://www.sap.com/cmp/oth/crm-s4hana/s4hana-on-premise.html
https://cal.sap.com/catalog#/support
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3 Licenses & fees 

SAP Cloud Appliance Library is a delivery channel for quickly using SAP on-premise software products in a 

hyperscaler environment. 

Therefore, three separate license / cost factors need to be considered, each depending on the duration that your 

system should be used:  

a) the SAP on-premise product (e.g., SAP S/4HANA) 

b) SAP Cloud Appliance Library 

c) the chosen cloud provider 

 

This table gives an overview about the different aspects. Details are mentioned in the paragraphs afterwards. 

The third column in the table below (on-premise installation) is an alternative to SAP Cloud Appliance Library and 

not covered in detail in this document (please see SAP Note 2041140 for details). 

 

 

 

 

 

https://launchpad.support.sap.com/#/notes/2041140
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 First 30 days: Running your appliance as trial 

In the first 30 days, the SAP license fees (Cloud Appliance Library & S/4HANA) are waived. During this period, 

you only need to bear the hosting fees of your cloud provider.  

The 30-day period starts when you accept the form for the trial agreement in the Cloud Appliance Library console 

(after clicking on “Create Appliance”).   

During the instantiation, the S/4HANA system will generate a temporary license key that is enough for exploration 

purposes.  

 Beyond 30 days: Running your appliance with SAP licenses  

If you want to use an appliance beyond the 30-day trial period (i.e. unlock the appliance template in SAP CAL), you 

need to obtain two SAP licenses: 

1. The SAP Cloud Appliance Library (SAP CAL) subscription 

2. The SAP product licenses for the product(s) that are bundled within your appliance 

 

The validity of these licenses will be automatically checked after the first 30 days. In case of a missing license 

component an error message will be displayed in the SAP Cloud Appliance Library console and the respective 

appliance will stay in status “Suspended”. 

The cloud provider fees will stay the same as during the first 30 days. 

You can continue to use a trial appliance from the first 30 days under these conditions, all your changes in that 

appliance will be preserved once you unlock the appliance template.  

3.2.1   SAP Cloud Appliance Library subscription 

You can purchase the subscription package via the SAP Store on 

https://www.sapstore.com/solutions/99007/SAP-Cloud-Appliance-Library. 

The minimum subscription is 3 months for one appliance (i.e., you can have exactly one appliance active at a time 

during these 3 months). You can also choose longer subscription periods and higher appliance numbers (i.e., you 

can activate multiple appliance templates in parallel).  

In the SAP Store, you will need an S-user that has the “SAP Store buyer role” assigned.  

Please make sure that the SAP Store user and the SAP CAL user belong to the same organization, otherwise the 

mapping between the license and the to-be-unlocked appliance is not possible. In case these two users do now 

belong to the same organization, please see this blog how to resolve this.  

https://calstatic.hana.ondemand.com/res/docEN/96d12c4fb8ff4fd4a61e5dcc55cd16c4.html
https://www.sapstore.com/solutions/99007/SAP-Cloud-Appliance-Library
https://blogs.sap.com/2017/02/08/how-to-keep-an-expiring-trial-instance-in-sap-cloud-appliance-library/
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3.2.2 SAP product licenses 

3.2.2.1 SAP S/4HANA Enterprise Mgmt. & SAP HANA DB 

To use an appliance under your own SAP Product License Agreements, you need to possess at least a license for 

the SAP HANA DB (application runtime) and for SAP S/4HANA Enterprise Management professional use.  

If you don’t possess these (trial) licenses already, you can either obtain them via your SAP account executive, or 

online as self-service by licensing the free SAP S/4HANA 90-day trial in SAP Store.  

The Cloud Appliance Library infrastructure checks whether the customer/partner organization of the S-user who 

created the appliance in SAP Cloud Appliance Library possesses these licenses. Only if this check is passed, the 

appliance can be activated in SAP Cloud Appliance Library beyond 30 days. 

The licenses entitle your organization to use the virtual appliance, however, since technically you will still be 

running under the 90-day temporary license key, we recommend generating your own license key and apply it to 

your system as soon as possible. 90 days after the initial appliance creation, the appliance will stop working 

without these technical license keys (see the next chapter for details). 

 

Note:  

At least the following separately licensed SAP S/4HANA capabilities are also configured and described in the pre-

configured demo scenarios of the virtual appliance. These capabilities will technically work in your appliance 

without entering dedicated license keys for them, however, they might not be part of your customer-specific 

license agreement for implementation / production systems. 

 

• SAP S/4HANA Finance for cash mgmt. 

• SAP S/4HANA Finance for receivables mgmt. 

• SAP S/4HANA for advanced compliance reporting 

• SAP Business Planning and Consolidation, add-on for S/4HANA 

• SAP S/4HANA for extended planning 

• SAP S/4HANA Advanced Available-to-Promise 

• SAP S/4HANA for Advanced Variant Configuration, standard 

• SAP Portfolio and Project Management for SAP S/4HANA professional 

• SAP Enterprise Master Data Governance for SAP S/4HANA 

3.2.2.2 Optional: SAP BusinessObjects BI Platform licenses 

If you chose to use the optional SAP BusinessObjects Platform in your appliance the temporary license key for BI 
will be valid for 30 days.  It needs to be replaced by your own permanent key for the BI platform after that time if 
you want the BI platform to work. 
 
If you don’t apply a permanent license key, the BI platform cannot be used anymore.  
The other appliance components (S/4HANA etc.) will not be affected and can be used even without the BI 
platform.  

https://www.sapstore.com/solutions/51010/SAP-S-4HANA-Trial
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 Beyond 90 days: License key installation required 

Latest 90 days after appliance creation (but better directly after unlocking the appliance template in Cloud 

Appliance Library after 30 days), you need to apply a valid license key to the system components.  

• SAP S/4HANA 

• SAP HANA database 

• SAP NetWeaver J2EE platform 

• Optional: SAP BusinessObjects BI platform 

The first three are part of the SAP S/4HANA license; the BI platform needs to be licensed separately.  

 

To get license keys for your system components, you first need to register them as a customer installation (see 

https://support.sap.com/en/my-support/systems-installations.html).  

Afterwards you can request license keys via the SAP license key application 

(https://support.sap.com/licensekey).  

During the license key generation, you will be asked for certain parameters (hardware keys and other system 

properties). The table below has the details. 

For S/4HANA and JAVA, you can also choose to generate a “Maintenance Certificate” together with the license 

key. The Maintenance Certificate is valid for 3 months and only needed for advanced system operations e.g., the 

installation of add-ons or support packages. It doesn’t affect the system in general so you can decide whether to 

take it or not. More details are here.  

 

For more information about how to generate and install product license keys, please see: 

a) This blog for an overview 

b) Step-by-step video (using an SAP-internal license key but the principle is the same for customers & 

partners) 

 

SID Product Version DB OS Comment Where to get the hardware key and apply 

the license key  

HDB SAP HANA, 

platform edition 

SAP HANA 

2.0, platform 

edition 

- Linux License type: SAP In-

memory Appliance 

platform 

Quantity: 256 GB 

Memory Volume  

HANA Studio: log on to system DB with 

SYSTEM user; right-click on system → 

Properties → Licenses. 

HANA Studio on remote desktop has pre-

configured entry for system DB. 

In a local HANA Studio use host name 

vhcalhdbdb or IP address of ABAP/JAVA 

VM; instance number 02; multiple 

containers > system database. 

S4H SAP S/4HANA SAP 

S/4HANA 

2021 

SAP 

HANA 

database 

Linux N/A Log on to S/4HANA with SAP GUI and use 

tCode /nSLICENSE 

J2E SAP NetWeaver SAP 

NetWeaver 

7.5 

Sybase 

ASE 

Linux As license type, select 

'J2EE - Web AS JAVA' 

 

 

https://vhcalj2eci.dummy.nodomain:500

01/nwa with Administrator user → 

Configuration → Infrastructure → 

Licenses. 

https://support.sap.com/en/my-support/systems-installations.html
https://support.sap.com/licensekey
https://support.sap.com/en/release-upgrade-maintenance/maintenance-information/maintenance-certificate.html
https://caldocs.hana.ondemand.com/caldocs/help/Product_License_Keys.pdf
https://www.youtube.com/watch?v=x3CiNJWrygA
https://vhcalj2eci.dummy.nodomain:50001/nwa
https://vhcalj2eci.dummy.nodomain:50001/nwa
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SID Product Version DB OS Comment Where to get the hardware key and apply 

the license key  

BIP Optional:  

SAP 

BusinessObjects 

Business 

Intelligence 

platform 

SAP 

BusinessObje

cts Business 

Intelligence 

platform 4.3 

- Linux Material:  

Choose SAP BO BI 

Platform (with fitting 

license KPI e.g., 

concurrent sessions 

CS,…) and version XI 4.3 

BOE CMC 

(http://bihost:8080/BOE/CMC) → 

Licenses 

 

Note to SAP employees:  

You can generate SAP-internal license keys (18 months validity) directly in the license key application without 

having to register your system (just enter the needed parameters and the hardware key). 

 

3.3.1  What to do if your temporary license key has expired 

If you missed to install your own permanent license key before the temporary 90-day key has expired, your 

system will stop working, hence, if you experience connectivity errors roughly three months after the appliance 

creation think of an expired license key in the first place.  

The procedure is now a bit more difficult since you need to get to a fully-licensed HANA DB first before you can 

install the S/4 license key, therefore follow these steps:  

1. Apply the HANA DB license key as described above. When you log on to the HANA system DB with the 

SYSTEM user, you will only have limited options (incl. some warning messages), but the license key 

installation works as usual. 

2. Restart the S/4HANA ABAP system. The easiest way is to use the Reboot button in the CAL console, but 

you can also do it on Linux OS level with the sapcontrol command. 

3. When the S/4 appliance is active again, apply the license key to S/4HANA as described above. You need 

to do this in client 000 with the user SAP* / <Master_Password>. Afterwards, HANA and S/4HANA 

should run as before. 

4. Apply the JAVA server license key as described above within 30 minutes after a re-boot or activation of 

the appliance. After this period, the JAVA server will go down until the next reboot / re-activation. 

5. For SAP BusinessObjects (temporary license key expires after 30 days), apply the license key as 

described above (no special considerations).  

 

http://bihost:8080/BOE/CMC
https://support.sap.com/licensekey
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4 Security Aspects in SAP Cloud Appliance 
Library 

 Internet ports for accessing your system 

By default, the following ports are opened for your appliance (i.e., this is the inbound firewall of your cloud 

provider). The access from your local computer to your appliance happens via those ports (see 'Description' what 

port is used where).  

Please make sure that your outbound firewall (e.g., if you are behind a corporate firewall) allows access through 

the needed ports as well. If you encounter problems behind a firewall, a good test is to use a public network (e.g., 

from home) or test access via the delivered remote desktop.  

You can edit/add/remove ports manually in the appliance details (click on the appliance link in the Cloud 

Appliance Library console → Edit → Virtual Machine → Access Points). 

If you want to tighten the security, open as few ports as really needed for your scenario.  

Especially the port 3389 of the remote desktop could be exposed to hacking attacks from the Internet.  

 

Virtual 

Machine* 

Protocol Port (open by 

default) 

Description 

ABAP SSH 22 Used for secure connection to Linux-based server operating system 

ABAP HTTPS 44301,  44300  Used for access of a local web browser to appliance (Fiori etc.).  

44301 via Web Dispatcher, 44300 via ABAP ICM directly 

ABAP HTTP 50000 Standard HTTP port for ABAP 

ABAP HTTPS 8443 Access to integrated Cloud Connector 

ABAP SAP GUI 3200 Used for access of local SAP GUI to appliance 

ABAP TCP 3300 Used for connection of ABAP Development Tools (Eclipse-based) to SAP S/4HANA 

ABAP repository & RFC calls to other systems if intended 

ABAP TCP 30213 / 30215 Used for connection of SAP HANA Studio to HANA DB 

JAVA SSH 22 SSH connection to Linux operating system (e.g., for PuTTY) 

JAVA HTTPS 50001 Used for access to SAP NetWeaver Administrator and other web-based J2EE 

applications 

BIP SSH 22 Used for secure connection to Linux-based server operating system 

BIP HTTP 8080, 6400, 6405 Used for HTTP connection to BI platform 

WIN RDP 3389 Used for access from MS Windows remote desktop connection 

* ABAP = SAP S/4HANA  & SAP HANA DB;  

JAVA = SAP NetWeaver 7.50 AS JAVA incl. ADS (Adobe Document Service)  

BIP = SAP BusinessObjects BI Platform 4.2 
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WIN = MS Windows Remote Desktop 

 

 Further network security considerations 

Be aware that creating your appliances in the public zone of your cloud provider (i.e., the “open Internet”) is 

convenient but less secure than providing it within your corporate network.  

In addition, we also recommend that you limit the access to your appliances by defining a whitelisted IP range of 

IP addresses that may access your appliance (e.g., the subnet of your company). With this, only computers within 

the white-listed IP range can access your system via the specific port. You can maintain the IP Range settings in 

the Cloud Appliance Library console → Edit → Virtual Machine → Access Points., using CIDR notation.  

The more complex but also more secure alternative to public Internet is to set up a virtual private cloud (VPC) or 

other dedicated access channels from your corporate network, please see the documentation of your hyperscaler 

how to do this.  

Note that when using HANA based appliances, HANA systems are not installed individually but cloned from a 

template system. Because of this cloning process, the existing root keys are cloned. For more information, see 

this SAP Note 2134846 - HANA encryption key handling during system cloning. 

 ABAP user roles and profiles  

The ABAP business users listed in chapter 2 have a large set of roles and extensive authorizations (including the 

SAP_ALL profile).  

If you plan to release the appliance to a larger set of users (especially in the Internet scenario), it is advised to 

restrict/lock the access with these users (or change the initial passwords) and create your own users with fitting 

roles and authorizations (see also the section “Recommended post-installation steps” earlier in this document). 

This can be done with the standard user management capabilities (e.g., tCode SU01, etc.). 

Please also note that the user BPINST is used in various RFC connections (tCode SM59) with its fixed password. If 

you lock the BPINST user or change its password, please also adapt these connections accordingly. 

 Certificates 

The appliance comes with a certificate that was self-signed by SAP. Most local browsers will issue a warning 

message that such a certificate is untrusted, and you will need to add the affected URLs (Fiori launchpad and 

others) to the list of trusted sites once.  

Hence, if you see messages about unsafe connections, untrusted certificates, etc., please click on “Proceed” or “I 

know the risk”, etc. (the screens and needed clicks will vary depending on the browser). 

As an alternative, you can also apply your own trusted certificate to the system if you have assigned your own 

host name as described in chapter 2.3.2 of this guide. 

On the demo walkthrough page a technical demo guide (in section (A) Demo Guides → Technical) explains how to 

install a free 90-day Let’s Encrypt SSL certificate. 

http://en.wikipedia.org/wiki/Classless_Inter-Domain_Routing
https://launchpad.support.sap.com/#/notes/2134846
https://blogs.sap.com/2019/04/23/sap-s4hana-fully-activated-appliance-demo-guides/
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Please be aware that the mentioned guide is meant to provide a quick workaround and might not comply with the 

security recommendations that are issued by your company or by SAP in general. 

 

On the delivered remote desktop, the self-signed certificate has already been imported into the store with trusted 

certificates, and you will not see a warning if you access the Fiori launchpad. The web sites of the J2EE server or 

the SAP Cloud Connector will still display warnings, please acknowledge the risk and continue as outlined above. 



 

  31 

 

5 Appliance Template Provisioning in SAP 
Cloud Appliance Library  

If you have a user in SAP Cloud Appliance Library, you need to meet the following prerequisites before starting to 

use the SAP Cloud Appliance library: 

 

Cloud Provider Configurations 

You have a valid account in one of the cloud providers supported by SAP Cloud Appliance Library. If you already 

have an active cloud provider account, you can proceed directly with the next section. Otherwise, navigate to the 

cloud provider home page and sign up. 

For more information about the supported cloud providers, see the FAQ page. 

 

Navigate to SAP Cloud Appliance Library 

Open the SAP Cloud Appliance Library in your Web browser using the following link: https://cal.sap.com  

For more information about how to use appliance templates in SAP Cloud Appliance Library, see the official 

documentation of SAP Cloud Appliance Library (choose Support → Documentation link and choose   (expand 

all) button to see all documents in the structure). You can also use the context help in SAP Cloud Appliance 

Library by choosing the Help panel from the right side. 

 

https://wiki.scn.sap.com/wiki/display/SAPCAL/SAP+Cloud+Appliance+Library+Public+Wiki
https://cal.sap.com/
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6 Appendix 

 Installed Technical Component Details 

6.1.1 SAP S/4HANA 2021 FPS02 on SAP ABAP application 
server 7.56 & SAP HANA DB 2.0.62 

The SAP Kernel release is 785 PL 100. 

 

 

Component Release SP-Level Support Package Short Description of Component 

SAP_BASIS 756 0002 SAPK-
75602INSAPBASIS 

SAP Basis Component 

SAP_ABA 75G 0002 SAPK-
75G02INSAPABA 

Cross-Application Component 

SAP_GWFND 756 0002 SAPK-
75602INSAPGWFND 

SAP Gateway Foundation 

SAP_UI 756 0003 SAPK-75603INSAPUI User Interface Technology 

ST-PI 740 0018 SAPK-74018INSTPI SAP Solution Tools Plug-In 

SAP_BW 756 0002 SAPK-
75602INSAPBW 

SAP Business Warehouse 

UIBAS001 700 0002 SAPK-
70002INUIBAS001 

UI for Basis Applications 

MDG_FND 806 0002 SAPK-
80602INMDGFND 

MDG Foundation 

S4FND 106 0002 SAPK-
10602INS4FND 

Foundation 

MDG_APPL 806 0002 SAPK-
80602INMDGAPPL 

MDG Applications 

S4CEXT 106 0002 SAPK-
10602INS4CEXT 

S4CEXT 

S4CORE 106 0002 SAPK-
10602INS4CORE 

S4CORE 

S4CRM 206 0002 SAPK-
20602INS4CRM 

S4CRM 

SAP_HR 608 0105 SAPKE608A5 Human Resources 

SAP_HRCAE 608 0105 SAPK-
608A5INSAPHRCAE 

Subcomponent SAP_HRCAE of 
SAP_HR 

SAP_HRCAR 608 0105 SAPK-
608A5INSAPHRCAR 

Subcomponent SAP_HRCAR of 
SAP_HR 

SAP_HRCAT 608 0105 SAPK-
608A5INSAPHRCAT 

Subcomponent SAP_HRCAT of 
SAP_HR 

SAP_HRCAU 608 0105 SAPK-
608A5INSAPHRCAU 

Subcomponent SAP_HRCAU of 
SAP_HR 
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SAP_HRCBE 608 0105 SAPK-
608A5INSAPHRCBE 

Subcomponent SAP_HRCBE of 
SAP_HR 

SAP_HRCBG 608 0105 SAPK-
608A5INSAPHRCBG 

Subcomponent SAP_HRCBG of 
SAP_HR 

SAP_HRCBR 608 0105 SAPK-
608A5INSAPHRCBR 

Subcomponent SAP_HRCBR of 
SAP_HR 

SAP_HRCCA 608 0105 SAPK-
608A5INSAPHRCCA 

Subcomponent SAP_HRCCA of 
SAP_HR 

SAP_HRCCH 608 0105 SAPK-
608A5INSAPHRCCH 

Subcomponent SAP_HRCCH of 
SAP_HR 

SAP_HRCCL 608 0105 SAPK-
608A5INSAPHRCCL 

Subcomponent SAP_HRCCL of 
SAP_HR 

SAP_HRCCN 608 0105 SAPK-
608A5INSAPHRCCN 

Subcomponent SAP_HRCCN of 
SAP_HR 

SAP_HRCCO 608 0105 SAPK-
608A5INSAPHRCCO 

Subcomponent SAP_HRCCO of 
SAP_HR 

SAP_HRCCZ 608 0105 SAPK-
608A5INSAPHRCCZ 

Subcomponent SAP_HRCCZ of 
SAP_HR 

SAP_HRCDE 608 0105 SAPK-
608A5INSAPHRCDE 

Subcomponent SAP_HRCDE of 
SAP_HR 

SAP_HRCDK 608 0105 SAPK-
608A5INSAPHRCDK 

Subcomponent SAP_HRCDK of 
SAP_HR 

SAP_HRCEG 608 0105 SAPK-
608A5INSAPHRCEG 

Subcomponent SAP_HRCEG of 
SAP_HR 

SAP_HRCES 608 0105 SAPK-
608A5INSAPHRCES 

Subcomponent SAP_HRCES of 
SAP_HR 

SAP_HRCFI 608 0105 SAPK-
608A5INSAPHRCFI 

Subcomponent SAP_HRCFI of 
SAP_HR 

SAP_HRCFR 608 0105 SAPK-
608A5INSAPHRCFR 

Subcomponent SAP_HRCFR of 
SAP_HR 

SAP_HRCGB 608 0105 SAPK-
608A5INSAPHRCGB 

Subcomponent SAP_HRCGB of 
SAP_HR 

SAP_HRCGR 608 0105 SAPK-
608A5INSAPHRCGR 

Subcomponent SAP_HRCGR of 
SAP_HR 

SAP_HRCHK 608 0105 SAPK-
608A5INSAPHRCHK 

Subcomponent SAP_HRCHK of 
SAP_HR 

SAP_HRCHR 608 0105 SAPK-
608A5INSAPHRCHR 

Subcomponent SAP_HRCHR of 
SAP_HR 

SAP_HRCHU 608 0105 SAPK-
608A5INSAPHRCHU 

Subcomponent SAP_HRCHU of 
SAP_HR 

SAP_HRCID 608 0105 SAPK-
608A5INSAPHRCID 

Subcomponent SAP_HRCID of 
SAP_HR 

SAP_HRCIE 608 0105 SAPK-
608A5INSAPHRCIE 

Subcomponent SAP_HRCIE of 
SAP_HR 

SAP_HRCIN 608 0105 SAPK-
608A5INSAPHRCIN 

Subcomponent SAP_HRCIN of 
SAP_HR 

SAP_HRCIT 608 0105 SAPK-
608A5INSAPHRCIT 

Subcomponent SAP_HRCIT of 
SAP_HR 

SAP_HRCJP 608 0105 SAPK-
608A5INSAPHRCJP 

Subcomponent SAP_HRCJP of 
SAP_HR 

SAP_HRCKR 608 0105 SAPK-
608A5INSAPHRCKR 

Subcomponent SAP_HRCKR of 
SAP_HR 
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SAP_HRCKW 608 0105 SAPK-
608A5INSAPHRCKW 

Subcomponent SAP_HRCKW of 
SAP_HR 

SAP_HRCKZ 608 0105 SAPK-
608A5INSAPHRCKZ 

Subcomponent SAP_HRCKZ of 
SAP_HR 

SAP_HRCMX 608 0105 SAPK-
608A5INSAPHRCMX 

Subcomponent SAP_HRCMX of 
SAP_HR 

SAP_HRCMY 608 0105 SAPK-
608A5INSAPHRCMY 

Subcomponent SAP_HRCMY of 
SAP_HR 

SAP_HRCNL 608 0105 SAPK-
608A5INSAPHRCNL 

Subcomponent SAP_HRCNL of 
SAP_HR 

SAP_HRCNO 608 0105 SAPK-
608A5INSAPHRCNO 

Subcomponent SAP_HRCNO of 
SAP_HR 

SAP_HRCNZ 608 0105 SAPK-
608A5INSAPHRCNZ 

Subcomponent SAP_HRCNZ of 
SAP_HR 

SAP_HRCOM 608 0105 SAPK-
608A5INSAPHRCOM 

Subcomponent SAP_HRCOM of 
SAP_HR 

SAP_HRCPH 608 0105 SAPK-
608A5INSAPHRCPH 

Subcomponent SAP_HRCPH of 
SAP_HR 

SAP_HRCPL 608 0105 SAPK-
608A5INSAPHRCPL 

Subcomponent SAP_HRCPL of 
SAP_HR 

SAP_HRCPT 608 0105 SAPK-
608A5INSAPHRCPT 

Subcomponent SAP_HRCPT of 
SAP_HR 

SAP_HRCQA 608 0105 SAPK-
608A5INSAPHRCQA 

Subcomponent SAP_HRCQA of 
SAP_HR 

SAP_HRCRO 608 0105 SAPK-
608A5INSAPHRCRO 

Subcomponent SAP_HRCRO of 
SAP_HR 

SAP_HRCRU 608 0105 SAPK-
608A5INSAPHRCRU 

Subcomponent SAP_HRCRU of 
SAP_HR 

SAP_HRCSA 608 0105 SAPK-
608A5INSAPHRCSA 

Subcomponent SAP_HRCSA of 
SAP_HR 

SAP_HRCSE 608 0105 SAPK-
608A5INSAPHRCSE 

Subcomponent SAP_HRCSE of 
SAP_HR 

SAP_HRCSG 608 0105 SAPK-
608A5INSAPHRCSG 

Subcomponent SAP_HRCSG of 
SAP_HR 

SAP_HRCSI 608 0105 SAPK-
608A5INSAPHRCSI 

Subcomponent SAP_HRCSI of 
SAP_HR 

SAP_HRCSK 608 0105 SAPK-
608A5INSAPHRCSK 

Subcomponent SAP_HRCSK of 
SAP_HR 

SAP_HRCTH 608 0105 SAPK-
608A5INSAPHRCTH 

Subcomponent SAP_HRCTH of 
SAP_HR 

SAP_HRCTR 608 0105 SAPK-
608A5INSAPHRCTR 

Subcomponent SAP_HRCTR of 
SAP_HR 

SAP_HRCTW 608 0105 SAPK-
608A5INSAPHRCTW 

Subcomponent SAP_HRCTW of 
SAP_HR 

SAP_HRCUA 608 0105 SAPK-
608A5INSAPHRCUA 

Subcomponent SAP_HRCUA of 
SAP_HR 

SAP_HRCUN 608 0105 SAPK-
608A5INSAPHRCUN 

Subcomponent SAP_HRCUN of 
SAP_HR 

SAP_HRCUS 608 0105 SAPK-
608A5INSAPHRCUS 

Subcomponent SAP_HRCUS of 
SAP_HR 

SAP_HRCVE 608 0105 SAPK-
608A5INSAPHRCVE 

Subcomponent SAP_HRCVE of 
SAP_HR 
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SAP_HRCZA 608 0105 SAPK-
608A5INSAPHRCZA 

Subcomponent SAP_HRCZA of 
SAP_HR 

SAP_HRGXX 608 0105 SAPK-
608A5INSAPHRGXX 

Subcomponent SAP_HRGXX of 
SAP_HR 

SAP_HRRXX 608 0105 SAPK-
608A5INSAPHRRXX 

Subcomponent SAP_HRRXX of 
SAP_HR 

EA-DFPS 806 0002 SAPK-
80602INEADFPS 

SAP Enterprise Extension Defense 
Forces & Public Security 

EA-HR 608 0105 SAPK-608A5INEAHR SAP Enterprise Extension HR 

EA-HRCAE 608 0105 SAPK-
608A5INEAHRCAE 

Subcomponent EA-HRCAE of EA-
HR 

EA-HRCAR 608 0105 SAPK-
608A5INEAHRCAR 

Subcomponent EA-HRCAR of EA-
HR 

EA-HRCAT 608 0105 SAPK-
608A5INEAHRCAT 

Subcomponent EA-HRCAT of EA-
HR 

EA-HRCAU 608 0105 SAPK-
608A5INEAHRCAU 

Subcomponent EA-HRCAU of EA-
HR 

EA-HRCBE 608 0105 SAPK-
608A5INEAHRCBE 

Subcomponent EA-HRCBE of EA-
HR 

EA-HRCBG 608 0105 SAPK-
608A5INEAHRCBG 

Subcomponent EA-HRCBG of EA-
HR 

EA-HRCBR 608 0105 SAPK-
608A5INEAHRCBR 

Subcomponent EA-HRCBR of EA-
HR 

EA-HRCCA 608 0105 SAPK-
608A5INEAHRCCA 

Subcomponent EA-HRCCA of EA-
HR 

EA-HRCCH 608 0105 SAPK-
608A5INEAHRCCH 

Subcomponent EA-HRCCH of EA-
HR 

EA-HRCCL 608 0105 SAPK-
608A5INEAHRCCL 

Subcomponent EA-HRCCL of EA-
HR 

EA-HRCCN 608 0105 SAPK-
608A5INEAHRCCN 

Subcomponent EA-HRCCN of EA-
HR 

EA-HRCCO 608 0105 SAPK-
608A5INEAHRCCO 

Subcomponent EA-HRCCO of EA-
HR 

EA-HRCCZ 608 0105 SAPK-
608A5INEAHRCCZ 

Subcomponent EA-HRCCZ of EA-
HR 

EA-HRCDE 608 0105 SAPK-
608A5INEAHRCDE 

Subcomponent EA-HRCDE of EA-
HR 

EA-HRCDK 608 0105 SAPK-
608A5INEAHRCDK 

Subcomponent EA-HRCDK of EA-
HR 

EA-HRCEG 608 0105 SAPK-
608A5INEAHRCEG 

Sub component EA-HRCEG of EA-
HR 

EA-HRCES 608 0105 SAPK-
608A5INEAHRCES 

Subcomponent EA-HRCES of EA-
HR 

EA-HRCFI 608 0105 SAPK-
608A5INEAHRCFI 

Subcomponent EA-HRCFI of EA-HR 

EA-HRCFR 608 0105 SAPK-
608A5INEAHRCFR 

Subcomponent EA-HRCFR of EA-
HR 

EA-HRCGB 608 0105 SAPK-
608A5INEAHRCGB 

Subcomponent EA-HRCGB of EA-
HR 

EA-HRCGR 608 0105 SAPK-
608A5INEAHRCGR 

Subcomponent EA-HRCGR of EA-
HR 

EA-HRCHK 608 0105 SAPK-
608A5INEAHRCHK 

Subcomponent EA-HRCHK of EA-
HR 
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EA-HRCHR 608 0105 SAPK-
608A5INEAHRCHR 

Subcomponent EA-HRCHR of EA-
HR 

EA-HRCHU 608 0105 SAPK-
608A5INEAHRCHU 

Subcomponent EA-HRCHU of EA-
HR 

EA-HRCID 608 0105 SAPK-
608A5INEAHRCID 

Subcomponent EA-HRCID of EA-HR 

EA-HRCIE 608 0105 SAPK-
608A5INEAHRCIE 

Subcomponent EA-HRCIE of EA-HR 

EA-HRCIN 608 0105 SAPK-
608A5INEAHRCIN 

Subcomponent EA-HRCIN of EA-HR 

EA-HRCIT 608 0105 SAPK-
608A5INEAHRCIT 

Subcomponent EA-HRCIT of EA-HR 

EA-HRCJP 608 0105 SAPK-
608A5INEAHRCJP 

Subcomponent EA-HRCJP of EA-
HR 

EA-HRCKR 608 0105 SAPK-
608A5INEAHRCKR 

Subcomponent EA-HRCKR of EA-
HR 

EA-HRCKW 608 0105 SAPK-
608A5INEAHRCKW 

Subcomponent EA-HRCKW of EA-
HR 

EA-HRCKZ 608 0105 SAPK-
608A5INEAHRCKZ 

Subcomponent EA-HRCKZ of EA-
HR 

EA-HRCMX 608 0105 SAPK-
608A5INEAHRCMX 

Subcomponent EA-HRCMX of EA-
HR 

EA-HRCMY 608 0105 SAPK-
608A5INEAHRCMY 

Subcomponent EA-HRCMY of EA-
HR 

EA-HRCNL 608 0105 SAPK-
608A5INEAHRCNL 

Subcomponent EA-HRCNL of EA-
HR 

EA-HRCNO 608 0105 SAPK-
608A5INEAHRCNO 

Subcomponent EA-HRCNO of EA-
HR 

EA-HRCNZ 608 0105 SAPK-
608A5INEAHRCNZ 

Subcomponent EA-HRCNZ of EA-
HR 

EA-HRCOM 608 0105 SAPK-
608A5INEAHRCOM 

Subcomponent EA-HRCOM of EA-
HR 

EA-HRCPH 608 0105 SAPK-
608A5INEAHRCPH 

Subcomponent EA-HRCPH of EA-
HR 

EA-HRCPL 608 0105 SAPK-
608A5INEAHRCPL 

Subcomponent EA-HRCPL of EA-
HR 

EA-HRCPT 608 0105 SAPK-
608A5INEAHRCPT 

Subcomponent EA-HRCPT of EA-
HR 

EA-HRCQA 608 0105 SAPK-
608A5INEAHRCQA 

Subcomponent EA-HRCQA of EA-
HR 

EA-HRCRO 608 0105 SAPK-
608A5INEAHRCRO 

Subcomponent EA-HRCRO of EA-
HR 

EA-HRCRU 608 0105 SAPK-
608A5INEAHRCRU 

Subcomponent EA-HRCRU of EA-
HR 

EA-HRCSA 608 0105 SAPK-
608A5INEAHRCSA 

Subcomponent EA-HRCSA of EA-
HR 

EA-HRCSE 608 0105 SAPK-
608A5INEAHRCSE 

Subcomponent EA-HRCSE of EA-
HR 

EA-HRCSG 608 0105 SAPK-
608A5INEAHRCSG 

Subcomponent EA-HRCSG of EA-
HR 

EA-HRCSI 608 0105 SAPK-
608A5INEAHRCSI 

Subcomponent EA-HRCSI of EA-HR 
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EA-HRCSK 608 0105 SAPK-
608A5INEAHRCSK 

Subcomponent EA-HRCSK of EA-
HR 

EA-HRCTH 608 0105 SAPK-
608A5INEAHRCTH 

Subcomponent EA-HRCTH of EA-
HR 

EA-HRCTR 608 0105 SAPK-
608A5INEAHRCTR 

Subcomponent EA-HRCTR of EA-
HR 

EA-HRCTW 608 0105 SAPK-
608A5INEAHRCTW 

Subcomponent EA-HRCTW of EA-
HR 

EA-HRCUA 608 0105 SAPK-
608A5INEAHRCUA 

Subcomponent EA-HRCUA of EA-
HR 

EA-HRCUN 608 0105 SAPK-
608A5INEAHRCUN 

Subcomponent EA-HRCUN of EA-
HR 

EA-HRCUS 608 0105 SAPK-
608A5INEAHRCUS 

Subcomponent EA-HRCUS of EA-
HR 

EA-HRCVE 608 0105 SAPK-
608A5INEAHRCVE 

Subcomponent EA-HRCVE of EA-
HR 

EA-HRCZA 608 0105 SAPK-
608A5INEAHRCZA 

Subcomponent EA-HRCZA of EA-
HR 

EA-HRGXX 608 0105 SAPK-
608A5INEAHRGXX 

Subcomponent EA-HRGXX of EA-
HR 

EA-HRRXX 608 0105 SAPK-
608A5INEAHRRXX 

Subcomponent EA-HRRXX of EA-
HR 

EA-PS 806 0002 SAPK-80602INEAPS SAP Enterprise Extension Public 
Services 

FI-CAX 806 0002 SAPK-80602INFICAX FI-CA Extended 

INSURANCE 806 0002 SAPK-
80602ININSURANC 

SAP Insurance 

IS-OIL 806 0002 SAPK-80602INISOIL IS-OIL 

IS-PRA 806 0002 SAPK-80602INISPRA SAP IS-PRA 

IS-PS-CA 806 0002 SAPK-
80602INISPSCA 

IS-PUBLIC SECTOR CONTRACT 
ACCOUNTING 

IS-UT 806 0002 SAPK-80602INISUT SAP Utilities/Telecommunication 

S4COREOP 106 0002 SAPK-
10602INS4COREOP 

S/4HANA, On-Premise only parts 

S4DEPREC 106 0002 SAPK-
10602INS4DEPREC 

S/4HANA, deprecation parts 

GBX01HR 600 0019 SAPK-
60019INGBX01HR 

FIORI X1 HCM 

GBX01HR5 605 0022 SAPK-
60522INGBX01HR5 

FIORI X1 HCM 

UIAPFI70 900 0002 SAPK-
90002INUIAPFI70 

UI SFIN 

UIHR001 100 0018 SAPK-
10018INUIHR001 

UI for ERP Human Capital 
Management 

UIHR002 100 0018 SAPK-
10018INUIHR002 

UI for ERP Human Capital 
Management 100 

UIS4HOP1 700 0002 SAPK-
70002INUIS4HOP1 

UI for S/4HANA On Premise 

PERSONAS 300 0012 SAPK-
30012INPERSONAS 

PERSONAS - SAP GUI 
PERSONALISATION 

ST-A/PI 01U_731 0003 SAPKITABC2 Servicetools for SAP Basis 731 and 
higher 
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6.1.2  SAP HANA Database & Plug-In Versions  

HANA Version 2.00.062.00.1650891137 (fa/hana2sp06) 

 

Plug-in Full version 

AFL 2.00.062.00.1650891137 

LCAPPS 2.00.062.00.1650891137 

SAP_AFL_SDK_APL 4.203.2211.0 

VCH2021 2.00.062.00 Build 1650891137-1530 

6.1.3  SAP NetWeaver 7.50 application server JAVA with Adobe  
Document Services installed  

Product Name Name Version Vendor Description 

SAP NETWAVER 
J2EE 

7.50 16 sap.com SAP NETWEAVER 7.5: Adobe Document Services 

SAP NETWAVER 
J2EE 

7.50 16 sap.com SAP NETWEAVER 7.5: Application Server Java 

6.1.4  Windows Remote Desktop 

o SAP GUI & SAP Business Client 7.70 (with Webview2 plugin for Edge) 

o MS PowerShell script for installing SAP HANA Studio & ABAP Development Tools 

o SAP Lumira 2.4 (Discovery & Designer) 

o Google Chrome 

o Mozilla Firefox 

 

6.1.5  SAP BusinessObjects BI Platform 4.3 

o SBOP BI PLATFORM 4.3 SERVER LINUX (64B)  

o SAP Lumira Server for BI Platform 
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